Introduction

To

Microsoft

Access 2000

Table of Contents

1Section 1—Getting Started


1Database Terms


1The Access Screen


2Section 2—Creating a Table


2Table Wizard


3Entering Data


3Navigating Through Data


4Opening a Table


4Changing the Width of a Column or Height of a Row


4Deleting Records


5Save the Datasheet


6Designing Your Own Table


6Guidelines for Naming Fields


6What Data Type Should I Use for My Fields


12Section 2 Exercises


13Section 3—find, filter, and sort


13Finding a Record


13Finding a Record Using Limited Information


13Filtering


15Sorting


15Complex Sorts


16Section 4—Reports


16Create a Report


16Customizing a report


18Section 4 Exercise


19Section 5—Queries


19Create a Simple Query with a Wizard


19Parameter Queries


20Examples of criteria for queries




Section 1—Getting Started

Microsoft Access is a database program.  Database programs are used to store lists of information such as address lists, customer lists, inventories, and medical records.  Once data is entered into a database program, that data can then be manipulated.  For example, it can be sorted, grouped, filtered for certain records, and reported.

Database Terms

In Microsoft Access, database files consist of tables.  You can have one table in a database file or several tables.  Access is a relational database, which means that the tables can be lined to each other.  These tables consist of fields and records.

Fields are the individual units of a table.  They are the categories of information you will be entering into a table.  Examples of fields are FirstName, LastName, Address, City, State, Zip, and Phone.  When you create a table, you make up the field names.

Records are the combination of all the fields put together to make one entry.  An example of a record would be the address for one person or the medical record for one person.

The Access Screen

After starting the Access program, you should see the following screen:

Figure 1—Access Screen

[image: image1.wmf]
Section 2—Creating a Table

You can create a table using the Table Wizard or by designing it yourself.

Table Wizard

The Table Wizard guides you through setting up a table.  You can create a table with the Table Wizard and then customize it to fit your needs.

Creating a Table with Table Wizard

1. In the Database window, click on the Tables object

2. Double-click on “Create table by using wizard”
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3. A list of sample tables appears.  Select the desired table.

4. A list of sample fields is displayed.  Double0click on each field you want in the table or click on the field name and click on the right arrow button.  To remove a field, click on the left arrow button.  To add all fields, click on the double-right arrow button.

5. Click the Next button

6. Type a name for the table or leave the suggestion

7. You can have Access set a primary key for you or you can set your own.  Click on Next.

(A Primary Key is a field that contains unique records.  It is used to identify tables usually for building relationships.)


8. You can choose to modify the table design, enter data directly into the table, or have access set up a form for you to enter data with.  Click on your selection and click on the Finish button.  You can now modify the design of the table or add records to the table.

Example:  Creating an Employees Table Using Table Wizard
Follow these steps to create a new database called Projects and a table called Employees using the Table Wizard:

1. Create a New Database file by clicking on the New tool on the standard toolbar

2. Name the database Projects and press Enter
3. Click on the Tables object in the Database window

4. Double-click on “Create table by using wizard”

5. Under Sample Tables click on Employees
6. Under Sample Fields, double-click on EmployeeNumber, FirstName, LastName, and WorkPhone.

7. Click on Next
8. Choose the option, No, I’ll set the primary key and click on Next
9. Under “What Field Will Hold Data that is Unique for Each Record,” make sure EmployeeNumber is selected.

10. Choose “Numbers and/or letters I enter when I add new records” , click on Next
11. Choose “Enter data into the table using a form the wizard creates for me” and click on Finish
12. A form for entering employee’s information will appear.

13. Click on the Save tool and name the form Employees Form.

Entering Data

To enter data, click on the first field and type the data.  Press the Tab or Enter key to move to the next field, or click with the mouse on the next field to enter data.  To move backwards to the previous field, press Shift-Tab.

Example:  Enter the following records in the Employees table:


1001, Sally Henson, 217-555-1000


1002, Walter Hill, 217-555-1111


1003, Sam Waters, 217-555-2000

Navigating Through Data

On a form, the white box in the lower left-hand corner displays the current record number.  

[image: image3.wmf]
Keyboard Field Navigation

	Next field
	Tab

	Previous field
	Shift-Tab

	Next record
	Ctrl-PgDn

	Previous record
	Ctrl-PgUp

	First record
	Ctrl-Home

	Last Record
	Ctrl-End


Example:  Navigation

Move through your data in the Employees form by using the Navigation buttons and the keyboard keys.

When finished, close the form by clicking on the X in the upper right-hand corner of the form.

Opening a Table

The new addresses you just typed are stored in the Employees table.  You can view the table in list view to see all of the records at once.

1. In the database window, click on the Tables object

2. Double-click on the Employees table to open it.  You are now in the datasheet view.

Changing the Width of a Column or Height of a Row

To change the width of a column:

1. Point to the right border of the field name in the gray area (top).  The mouse pointer turns into a double arrow.

2. Click and drag the border to the right or left.  Double-clicking performs a “best-fit” for the column.

To change the height of a row:

1. Point to the lower border of a record on the left side in the gray area.  The mouse pointer turns into a double arrow.

2. Click and drag the border upward or downward.

Hiding and Unhiding Columns

You can hide a column by dragging its right border all the way to the left border.  To unhide the column, choose the Unhide Columns command from the Format menu.

Deleting Records

1. Position your mouse to the left of a record in the gray area.  The mouse pointer turns into an arrow pointing to the right.

2. Click to select the entire record.

3. Pull down the Edit menu and choose Delete record (or just press the Delete key on the keyboard).

4. Click on Yes to delete the record or No to not delete the record.

Note:  You cannot undo a record deletion.

Save the Datasheet

If you change the formatting of a datasheet, such as resizing columns and rows, you’ll need to save the changes.  To save, click on the Save tool [image: image4.wmf]on the standard toolbar or pull down the File menu and choose Save.

Designing Your Own Table

Use the Design View to manually create your own tables.

1. Click on the Tables object in the Database window.

2. Double-click on “Create table in design view”

3. Enter field names, data types, and descriptions on the screen to set up the table.

Figure 3—Table Design View

[image: image5.png]K Microsoft Access |- [5]x]

D 1 b i G |

ERCIEE AR A

& Table2 : Table
Field hame [ DataType Description

Field Properties

Generl | ookp |

A field name can be up to 64 characters long, including spaces, Press Fi for help on feld nares

[Desian view. F6 = Swich panes. F1 = Help, I o

SR Start| B )intoducion o Access 200, [ Microsoft Accoss





Guidelines for Naming Fields

Names of fields can be:

· Can be up to 64 characters long.

· Can include any combination of letters, numbers, spaces, and special characters except a period (.), an exclamation point (!), an accent grave (`), and brackets ([ ]).

· Can't begin with leading spaces.

· Can't include control characters (ASCII values 0 through 31).

· Can't include a double quotation mark (") in table, view, or stored procedure names in a Microsoft Access project. 

Note:  Although you can include spaces in field names, most examples in the Microsoft Access documentation show field names without spaces because spaces in names can produce naming conflicts in Visual Basic for Applications in some circumstances.

What Data Type Should I Use for My Fields

Decide what kind of data type to use for a field based on these considerations:

· What kind of values do you want to allow in the field? For example, you can't store text in a field with a Number data type.

· How much storage space do you want to use for values in the field?

· What types of operations do you want to perform on the values in the field? For example, Microsoft Access can sum values in Number or Currency fields, but not values in Text or OLE Object fields.

· Do you want to sort or index a field? OLE Object fields can't be sorted or indexed.

· Do you want to use a field to group records in queries or reports? OLE Object fields can't be used to group records.

· How do you want to sort values in a field? In a Text field, numbers sort as strings of characters (1, 10, 100, 2, 20, 200, and so on), not as numeric values. Use a Number or Currency field to sort numbers as numeric values. Also, many date formats will not sort properly if entered in a Text field. Use a Date/Time field to ensure proper sorting.

The following table summarizes all the field data types:

	Data type
	Use for
	Size

	Text
	Text or combinations of text and numbers, such as addresses. Also numbers that do not require calculations, such as phone numbers, part numbers, or postal codes. 
	Up to 255 characters. 

Microsoft Access only stores the characters entered in a field; it does not store space characters for unused positions in a Text field. 

	Memo
	Lengthy text and numbers, such as notes or descriptions. 
	Up to 64,000 characters.

	Number
	Numeric data to be used for mathematical calculations. Set the FieldSize property to define the specific Number type. 
	1, 2, 4, or 8 bytes. 16 bytes for Replication ID (GUID) only. 

See table below for more info. On Number FieldSize options.

	Date/Time
	Dates and times. 
	8 bytes.

	Currency
	Currency values. Accurate to 15 digits to the left of the decimal point and 4 digits to the right. 
	8 bytes.

	AutoNumber
	Unique sequential (incrementing by 1) or random numbers automatically inserted when a record is added. 
	4 bytes. 16 bytes for Replication ID (GUID) only.

	Yes/No
	Fields that will contain only one of two values, such as Yes/No, True/False, On/Off. 
	1 bit.

	OLE Object
	Objects (such as Microsoft Word documents, Microsoft Excel spreadsheets, pictures, sounds, or other binary data), created in other programs using the OLE protocol, that can be linked to or embedded in a Microsoft Access table. You must use a bound object frame in a form or report to display the OLE object. 
	Up to 1 gigabyte (limited by disk space).

	Hyperlink
	Field that will store hyperlinks. A hyperlink can be a UNC path or a URL. 
	Up to 64,000 characters.

	Lookup Wizard
	Creates a field that allows you to choose a value from another table or from a list of values using a combo box. Choosing this option in the data type list starts a wizard to define this for you. 
	The same size as the primary key field that is also the Lookup field; typically 4 bytes.


Number FieldSize Options:

	Setting
	Description
	Decimal precision
	Storage size

	Byte
	Stores numbers from 0 to 255 (no fractions).
	None
	1 byte

	Decimal
	Stores numbers from -10^38 -1 through 10^38 -1 (.adp)
Stores numbers from-10^28 -1 through 10^28 -1 (.mdb)
	28
	12bytes

	Integer
	Stores numbers from –32,768 to 32,767 (no fractions).
	None
	2 bytes

	Long Integer
	(Default) Stores numbers from –2,147,483,648 to 2,147,483,647 (no fractions).
	None
	4 bytes

	Single
	Stores numbers from
–3.402823E38 to
–1.401298E–45 for negative values and from
1.401298E–45 to 3.402823E38 for positive values.
	7
	4 bytes

	Double
	Stores numbers from
–1.79769313486231E308 to
–4.94065645841247E–324 for negative values and from 1.79769313486231E308 to 4.94065645841247E–324 for positive values.
	15
	8 bytes

	Replication ID
	Globally unique identifier (GUID)
	N/A
	16 bytes


Note on Field Formats

Number, Date/Time, Currency, and Yes/No data types provide predefined display formats.  Set the Format property to choose from the formats available for each data type.  You can also create a custom display format for all data types except the OLE Object data type.  See Microsoft Access Help for more information on creating custom display formats.

Date Formats and Year 2000

It is very important to enter years in the four-digit format.  Follow these steps to do so:

1. Change data type to Date/Time
2. In the format area, for a short date format, type mm/dd/yyyy
3. If you want to use an input mask, click on the Input Mask line

4. Click on the button with three dots in it and then click on Yes to save the table.

5. Click on Short Date and then the Next button

6. In the Input area, add two more zeros (0) to make the year four digits

7. Click on Next and then Finish.

Example:  Creating a Projects Table

1. In the Database windows, click on the Tables object

2. Double-click on “Create table in design view”
3. In the Field Name area, type ProjectsID
4. Click on the Primary key tool [image: image6.wmf] on the standard toolbar to make this field a primary key

5. Change the data type to AutoNumber by clicking on the drop-down arrow and choosing AutoNumber then hit the Tab key twice

6. The next field is ProjectName and data type is Text.

7. The next field is EmployeeNumber.  Follow these steps to set the data type to Lookup:

LOOKUP WIZARD
- Change the data type to Lookup Wizard
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- Choose to look up the values from another table or to type the values yourself.  In this example, keep the default.
- Click on the Next button
- Choose a Table or Query for the lookup column and click Next.  In this example, leave Employees and click on Next.
- Select the fields to be displayed when looking up to this table.  In this example, choose all of the fields
- In this example, unhide the key column by unchecking “Hide key column”
- Click on Next
- In this example EmployeeNumber should be highlighted and click on Next
- In this example SS# is displayed for the field label, click on Finish
- Click on Yes to save the table and name it Projects.


8. The next field is ProjectCost and the data type is currency with zero decimal places

9. The next field is BeginDate and the data type is date/time and format is short date with a four-digit year.  Set up the Input Mask also for a four-digit year.

10. The next field is EndDate with the same data type as BeginDate.

11. Click on the Save tool to save the structure of the table.

12. Close the table.

Example:  Create a Form for Entering Data in the Projects Table

1. Select the table in the Database Window

2. Pull down the Insert menu

3. Choose AutoForm.  A very simple form will be created for you.

4. Click on the Save tool and save the form as Projects Form.

Example:  Entering Data in the Projects Table

Enter the following data into the Projects table using the form you just created.  The ProjectsID field is an AutoNumber field, so just Tab over it (press the Tab key).  

1. Patient Care, Sally Henson, 1200, 07/01/1999, 02/10/2000

2. Patient Accounts, Sally Henson, 1500, 08/01/1999, 01/15/2000

3. Doctor Accounts, Walter Hill, 2000, 09/01/1999, 03/01/2000

4. Doctor Scheduling, Walter Hill, 1000, 09/01/1999, 03/01/2000

5. Employee Accounts, Sam Waters, 2500, 08/01/1999, 02/15/2000

Section 2 Exercises

Exercise 1

1. Create a new blank database and name it Expenses
2. Create a new table using the Table Wizard
3. Under Sample Tables, choose Expenses
4. Add all of the suggested fields to the table and click on Next.

5. Leave the table name as Expenses and Yes for primary key and click on Next
6. Choose “Enter data into the table using a form the wizard create for me” and click on Finish.

7. Close the Expenses form and choose Yes to save it.  Name it Expenses Form.

Exercise 2

1. Add another table to the Expenses database by using the design view.

2. The only field name to enter is PaymentMethod and leave the data type as Text.

3. Set PaymentMethod as the Primary Key.

4. Click on the View tool to switch to the datasheet view and add the following records:

Cash
Check
Credit Card


5. Close the table and Save it as Payment Method.

Exercise 3

1. Open the Expenses table in design view [image: image8.wmf]
2. Click on the Payment Methods field

3. Change the type to Lookup Wizard and have the Payment Methods table as the lookup table.  

4. Save and close out of the design view.

Exercise 4

The Expenses form that was created by the wizard is no longer valid, since you changed the PaymentMethods field to a Lookup.  Create a new form by:

1. Delete the Expenses form by selecting and pressing the Delete key on your keyboard.

2. Select the Expenses table 

3. Pull down the Insert menu and choose AutoForm.

4. Enter data, making it up as you go.

Section 3—find, filter, and sort

Finding a Record

1. With a form or table open, click in the field to search through 

2. Click on the Find button [image: image9.wmf]on the toolbar

3. In the Find What box, type the text to be found

4. The Search Only Current Field should be checked to search through the current field only.  If this is not selected, Access searches through the entire table.

5. Click the Find First button

6. To find the next occurrence, click on the Find Next button

7. When finished, click on the Close button.

Finding a Record Using Limited Information

You can find a record if you know just part of a field entry.

1. Click on the field to search through

2. Click on the Find button[image: image10.wmf]
3. In the Find What box, type the text that you know

4. In the Match box, select Any Part of Field

5. Click the Find First button

6. To find the next occurrence, click on the Find Next button

7. When finished, click on the Close button

Filtering

You can filter a table or form to show only the records that meet a certain criteria.

Filter by Selection

Filter by selection filters on the current field by the data you have selected.  

Use this method to create a new filter or further limit records returned from a filter you originally created in the Filter By Form window or the Advanced Filter/Sort window.

1. In a field on a form or datasheet, find one instance of the value you want records to contain to be included in the filter’s results.

2. Select the value and then click on the Filter by Selection tool.[image: image11.wmf]
3. Click on the Remove Filter tool [image: image12.wmf]to show all the records again.

How you select the value determines what records the filter returns.  You can select all or part of a value in a field:

	Selecting
	Finds records in which
	Example

	The entire contents of a field (or placing the insertion point in a field without selecting anything)
	The entire contents of that field matches the selection.
	You select the value "Berlin" in the City field. The filter returns all records with Berlin as the city.

	Part of a value starting with the first character in a field
	The value in that field starts with the same characters you selected.
	In the CompanyName field containing the value "France restauration," you select only "Fran." The filter returns all records that have a company name starting with "Fran," such as Franchi S.p.A. and Frankenversand.

	Part of a value starting after the first character in a field
	All or any part of the value in that field contains the same characters you selected.
	In the CompanyName field containing the value "Old World Delicatessen," you select the letters "Del." The filter returns all records that have "del" anywhere in the CompanyName field, such as Ernst Handel, Galería del gastrónomo, and Que Delícia.


Filtering by Form

Filtering by form allows you to add more criteria to the filter.

1. Click on the Filter by Form button on the toolbar.[image: image13.wmf]
2. A dialog box appears.  Type the criteria below the appropriate field name

3. You can type criteria below more than one field, however, the record must match all of the criteria to be displayed by the filter.

4. Click on the Apply Filter button.  The filter is applied and only the records matching the criteria are displayed.

5. To see all the records again, click on the Remove Filter button.  [image: image14.wmf] (The Apply Filter button becomes the Remove Filter button after you apply a filter.)

Sorting

1. Click in the field to sort by

2. Click on either the Sort Ascending [image: image15.wmf] (from A-Z or lowest number to highest number) button or the Sort Descending  (from Z-A or highest number to lowest number) button.

Complex Sorts

Create an Advanced Sort to sort by LastName and then FirstName by following these steps:

1. Pull down the Records menu and choose Filter

2. Choose Advanced Filter/Sort

3. At the bottom of the screen, click to the right of Field. Click on the drop-down arrow and choose LastName

4. Click to the right of Sort. Click on the drop-down arrow and choose ascending.

5. Click in the next column for Field and choose FirstName and choose the sort order of ascending.

6. Click on the Apply Filter tool.

7. When you close the table, if you choose to save the design changes, the table will be saved in the sorted order.

Section 4—Reports

Reports allow you to print your data in a professional appearance.  You can choose which fields to be displayed in a report and how you want the data to look.

Create a Report

You can create a report on your own or you can have Microsoft Access create a report for you using a Report Wizard.  A Report Wizard speeds up the process of creating reports, because it does all of the basic work for you.  When you use a Report Wizard, it prompts you for information and creates a report based on your answers.

Example:  Create a Report for the Projects Table

1. In the Database window, click on the Reports object

2. Double-click on “Create Report by Using Wizard”

3. Under Tables/Queries choose Projects

4. Select ProjectName, ProjectCost, and EndDate to be in the report and click Next

5. We do not want to add any groupings, so click on Next.

6. Choose to sort by EndDate and then click Next.

7. Leave the Layout the way it is and click on Next

8. Leave the Style as Corporate and click on Next

9. Title the report Projects End Dates and click on Finish.

10. You are now previewing the report as it will look when printer.  Click on the Close button (not the X, but the button that spells out C-l-o-s-e on it).

Customizing a report

You can customize a report from the Report Design View.  The report is divided into several sections as listed below:

	Section
	Purpose

	Report Header
	Prints at beginning of report only (on first page)

	Page Header
	Prints at top of each page (can be altered from original form)

	Detail
	Contains the exact field names

	Page Footer
	Prints at bottom of each page

	Report Footer
	Prints at end of report (last page).  Place totals and such in the report footer.


Example:  Adding a Total to the Projects EndDate Report

1. In the toolbox, click the Text button and then click below the Report Footer

2. Click in the new label and type Grand Total and press Enter

3. Double-click the new text box.  The property sheet appears.

4. Click on the Data tab

5. In the Control Source box, type =sum([ProjectCost])
6. Click on the Format tab, click the drop-down arrow and select Currency.  

7. Click on Decimal Places and type 0.  

8. Close the property sheet.  


Example:  Formatting the Report

1. You can move the text box by pointing to the middle of the box until the mouse pointer changes to a hand then drag.

2. To put the total in bold, while the text box is selected, click on the Bold tool

3. You can change the appearance of the Column Headings in the Header area.  Click on the heading to select it, then click after the first word and press the space bar.

Section 4 Exercise

Create a report using the Projects database.  The report will include both the Projects table and the Employees table.  Follow these steps to create the report:

1. In the Database window, click on the Reports object

2. Double-click on “Create Report by Using Wizard”

3. Under Tables/Queries choose Projects

4. Double-click on EmployeeNumber to add it to the report

5. Under Tables/Queries choose Employees

6. Double-click on the FirstName and LastName fields to add them to the report

7. Under Tables/Queries choose Projects again

8. Add all of the remaining fields except for ProjectID to the report

9. Click on the Next button

10. Choose to view the data by Employees and click on Next

11. Do not add any groupings and click on Next

12. Do not sort by anything and click on Next

13. Leave the layout as is and click on Next

14. Leave the style as Corporate and click on Next

15. Title the report Employees’ Projects and click on Finish

16. When finished viewing the report, close the report and close the Report Design screen.

Section 5—Queries

Queries work like filters in that they display specified records from the table.

If you need to create a query, you don’t have to design it from scratch.  For certain types of queries, you can have Microsoft Access create the query for you using a Query Wizard.  A Query Wizard speeds up the process of creating a query because it does all the basic work for you.  When you use a query wizard, it prompts you for information and creates a query based on your answers.

You can also create a query from scratch by using the query Design View.

Create a Simple Query with a Wizard

1. In the Database window, click on the Queries object.

2. Double-click on “Create Query by using wizard”

3. Follow the directions in the wizard dialog boxes.  In the last dialog box, you can choose to run the query or see the query’s structure in Design View.

If the resulting query isn’t exactly what you want, you can rerun the wizard or change the query in Design View.

Example:  Create a Query Using Query Wizard in the Projects Table

Create a query to display only the projects for employee 1002.

1. In the Database window, click on the Queries object.

2. Double-click on “Create Query by using wizard”

3. Under Tables/Queries choose Projects

4. Click on the double right arrow button to select all fields and click on Next

5. Click on Detail and click on Next

6. The title should be Employee 1002 and click on Modify Query Design and then click on Finish.

Example:  Apply the Query

1. Under EmployeeNumber on the Criteria line, type 1002

2. Click on the run button [image: image16.wmf]
3. If the results aren’t quite what you want, pull down the View menu and choose Query Design (or click on the Design tool) and change the criteria.

4. Click on the Close button and then Yes to save the query.

Parameter Queries

A parameter query is a query that when run displays its own dialog box prompting you for information, such as criteria for retrieving records or a value you want to insert in a field. You can design the query to prompt you for more than one piece of information; for example, you can design it to prompt you for two dates. Microsoft Access can then retrieve all records that fall between those two dates.
Parameter queries are also handy when used as the basis for forms, reports, and data access pages. For example, you can create a monthly earnings report based on a parameter query. When you print the report, Microsoft Access displays a dialog box asking for the month that you want the report to cover. You enter a month and Microsoft Access prints the appropriate report. 

Creating a Parameter Query

1. Create a query.
2. In the Criteria cell for each field you want to use as a parameter, type a prompt enclosed in square brackets. Microsoft Access will display this prompt when the query is run. The text of the prompt must be different from the field name, although it can include the field name. 

3. For a field that displays dates, you can display the prompts "Type the beginning date:" and "Type the ending date:" to specify a range of values. In the field's Criteria cell, type Between [Type the beginning date:] And [Type the ending date:]. 

4. Run the Query and fill in the blanks when prompted.

Examples of criteria for queries

Examples of expressions that use text values as criteria:
	Field
	Expression
	Description

	ShipCity
	"London"
	Displays orders shipped to London.

	ShipCity
	"London" Or "Hedge End"
	Uses the Or operator to display orders shipped to London or Hedge End.

	ShippedDate
	Between #1/5/95# And #1/10/95#
	Uses the Between...And operator to display orders shipped no earlier than 5-Jan-95 and no later than 10-Jan-95.

	ShippedDate
	#2/2/95#
	Displays orders shipped on 2-Feb-95.

	ShipCountry
	In("Canada", "UK")
	Uses the In operator to display orders shipped to Canada or the UK.

	ShipCountry
	Not "USA"
	Uses the Not operator to display orders shipped to countries other than the USA.

	ShipName
	Like "S*"
	Orders shipped to customers whose name starts with the letter S.

	CompanyName
	>="N"
	Displays orders shipped to companies whose name starts with the letters N through Z.

	OrderID
	Right([OrderID], 2)="99"
	Uses the Right function to display orders with OrderID values ending in 99.

	CompanyName
	Len([CompanyName])
>Val(30)
	Uses the Len and Val functions to display orders for companies whose name is more than 30 characters long.


Examples of expressions that calculate or manipulate dates, and then use the result as criteria
	Field
	Expression
	Description

	RequiredDate
	Between Date( ) And DateAdd("m", 3, Date( ))
	Uses the Between...And operator and the DateAdd and Date functions to display orders required between today's date and three months from today's date.

	OrderDate
	< Date( )- 30
	Uses the Date function to display orders more than 30 days old.

	OrderDate
	Year([OrderDate])=1996
	Uses the Year function to display orders with order dates in 1996.

	OrderDate
	DatePart("q", [OrderDate])=4
	Uses the DatePart function to display orders for the fourth calendar quarter.

	OrderDate
	DateSerial(Year
([OrderDate]), 
Month([OrderDate])+1, 1)-1
	Uses the DateSerial, Year, and Month functions to display orders for the last day of each month.

	OrderDate
	Year([OrderDate])=
Year(Now()) And Month([OrderDate])=
Month(Now())
	Uses the Year and Month functions and the And operator to display orders for the current year and month.


Examples of expressions that use a blank field's value (Null or zero-length string) 
	Field
	Expression
	Description

	ShipRegion
	Is Null
	Displays orders for customers whose ShipRegion field is Null (blank).

	ShipRegion
	Is Not Null
	Displays orders for customers whose ShipRegion field contains a value.

	Fax
	" "
	Displays orders for customers who don't have a fax machine, indicated by a zero-length string value in the Fax field instead of a Null (blank) value.


Examples of expressions that use part of a field's value as criteria
	Field
	Expression
	Displays

	ShipName
	Like "S*"
	Orders shipped to customers whose names start with the letter S.

	ShipName
	Like "*Imports"
	Orders shipped to customers whose names end with the word "Imports".

	ShipName
	Like "[A-D]*"
	Orders shipped to customers whose names start with A through D.

	ShipName
	Like "*ar*"
	Orders shipped to customers whose names include the letter sequence "ar".

	ShipName
	Like "Maison Dewe?"
	Orders shipped to the customer with "Maison" as the first part of its name and a 5-letter second name in which the first 4 letters are "Dewe" and the last letter is unknown.


Examples of expressions that use the result of a domain aggregate function as criteria
	Field
	Expression
	Description

	Freight
	>(DStDev("[Freight]", "Orders") + DAvg("[Freight]", "Orders"))
	Uses the DAvg and DStDev functions to display all orders for which the freight cost rose above the mean plus the standard deviation for freight cost.

	Quantity
	>DAvg("[Quantity]", "Order Details")
	Uses the DAvg function to display products ordered in quantities above the average order quantity.


Examples of expressions that use the result of subqueries as criteria
	Field
	Expression
	Displays

	UnitPrice
	(SELECT [UnitPrice] FROM [Products] WHERE [ProductName] = "Aniseed Syrup")
	Products whose price is the same as the price of Aniseed Syrup.

	UnitPrice
	>(SELECT AVG([UnitPrice]) FROM [Products])
	Products that have a unit price above the average.

	Salary
	> ALL (SELECT [Salary] FROM [Employees] WHERE ([Title] LIKE "*Manager*") OR ([Title] LIKE "*Vice President*"))
	Salary of every sales representative whose salary is higher than that of all employees with "Manager" or "Vice President" in their titles.

	OrderTotal:
[Unit Price]*
[Quantity]
	> ALL (SELECT AVG([UnitPrice] * [Quantity]) FROM [Order Details])
	Orders with totals that are higher than the average order value.


Specifying multiple Criteria

Two Fields Using And:
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Two Fields Using Or:
Microsoft Access connects criteria in different rows with “or,” and finds records that meet the criteria in the first row or the second row.
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One Field Using Or:
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One Field Using And:
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Tips:


Press space bar to place a checkmark in a checkbox.





Press Alt-down arrow to see the items in a drop-down list.





Press Ctrl-" to repeat the entry in this field from the previous record.





Press Ctrl-Enter to enter data on a second line of a field.





Company name begins with H and region is RJ.





Company name begins with H or region is RJ.





Company name begins with “The” and includes the word “Box.”





Tips:


To select more than one object at a time, hold the Shift key while clicking on the objects.





To put another line in a title or column heading, press Ctrl-Enter where you’d like the new line to begin.





To draw a straight line, hold the Shift key while drawing the line.
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